




Welcome to I+ME ACTIA !

Before acquainting you with your new I+ME Hardware
we would first like to thank you for purchasing our
product. We are extremely pleased that you have
chosen to place your trust in I+ME ACTIA and will do
our best to satisfy whatever needs you may have. The
following is a brief explanation highlighting our
background, areas of expertise and general product
lines.  This products and the list of our world-wide
branch offices show that you have found a competent
partner in I+ME ACTIA.

Since its foundation in 1986, I+ME ACTIA has made
quite a name for itself.  Our employees are dedicated to
producing high-quality solutions in the field bus and
multiplexed systems sectors.  The knowledge of our
experts allows to develop a spectrum of products which
have been used in the automotive field as well as in
general industrial environments.  Our products can be
used in all phases of system development: system
definition, prototyping, evaluation and field application.

Informatik und MikroElektronik



Whether your professional background is into industry-
process-control or development and test tools, we offer
six product groups to fulfill your sophisticated needs.
Tried and tested under the most severe conditions the
automotive industry has to offer, our products have
proved themselves again and again.
Our six products groups are:

1 CAN System Test & Design Tools

Support of various user ap-
plication phases: Learning, proto-
typing, testing and evaluation of
networked systems. Comfortable
Real-Time simulation of message
transfer characteristics in CAN
networks. Tools for mobile

diagnosis and tests.

2 CAN PC Interfaces

Easy interfacing between PCs,
Laptops, notebooks and networks
with automotive fieldbus – proto-
cols. Available for all PC standard
interfaces such as ISA-slot, PCI,
backplane, RS232, Centronics
and PCMCIA. Development of

applications under DOS/Windows according to Real-
Time requirements is supported

3 CAN Industrial I/O
NiPC is an intelligent hardware
concept for sensor / actuator inter-
facing. A modular architecture al-
lows the flexible change target
micro controllers for process
control.



4 CAN System Application Software

Enabling Real-Time system
modeling, testing of networked
systems as well as application

support. Offering basic services
for network communication which
is applicable for various
processors and programming

languages. Facilitating the application interface for
distributed industrial process control according to the
CAL standard by CiA. Support of Windows 3.1,
Windows 95 & NT.

5 CAN System Know How

Promoting the understanding of
various network protocols in
practice. Understanding of CAN

networks with CAL in practice.
Developing HW/SW solutions for
customer specific problems. We
offer CAN / CAL workshops and
in-house seminars to enable CAN
users to benefit from I+ME
ACTIA’s extensive knowledge.

6 Automotive Diagnostics

Assistance during the development
phases. Diagnostic tools for quality
control in production lines as well as

after sales diagnostic, control and
servicing tools are provided to
manufacturers, suppliers and dealers
of the car industry by I+ME ACTIA.

If you have any questions concerning our products or
you look for specific solutions within our product groups,



don’t hesitate to call us and benefit from I+ME’s
extensive knowledge - your need is our desire.

Our merger with the french corporation ACTIA in 1995
allowed us to become a powerful supplier for the
European automotive industry.  ACTIA products include
diagnostic systems for automotive service and
maintenance as well as development and production of
high-quality on-board electronics. joining forces with
ACTIA has enabled I+ME to better service it’s
international customers not only in Europe, but
throughout the world.

Headquarter: Office Stuttgart:

I+ME ACTIA GmbH I+ME ACTIA GmbH
Rebenring 33 Zettachring 4, 1.OG
38106 Braunschweig 70567 Stuttgart
Germany Germany
T: +49 531 38701 0 T: +49 711 72874 45
F::+49 531 38701 88 F: +49 711 72874 46
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NOHAU ELEK. AB
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1 Introduction

I+ME NetTest III+. Overview
System Requirements, Delivery Contents and
Specifications.
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1.1 Your I+ME NetTest III+

The NetTest III is an improved portable network tester.
It is designed for hand-held diagnostics and
configuration of CAN based networked components.
With its features it is an ideal general purpose hardware
for automotive diagnostics.

With NetTest III+ you can visualize bus traffic within a
CAN network. Moreover you can store data on PCMCIA
memory cards to transfer them to the PC. The data can
be arranged to be understandable for standard PC
programs like Excel. In this way the user can generate
statistic diagrams, etc. to analyze the CAN
communication and to verify the timing on the CAN bus.

The software allows you to set bus specific values.
Some parameters will be detected automatically after
plug into a specified CAN network. The configuration of
the screens can be done quickly on the base of ASCII
files which contains all necessary information. The
ASCII files can be generated by standard editors or
imported by other tools. You can also interpret frames
data content in various ways and display text
commands.

In addition to the above mentioned features you can
transfer your own programs or configurations to
NetTest III by the use of a PC card. A PC application for
handling of the PC cards is included into the standard
delivery contents.
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I+ME ACTIA is always eager to fulfil the needs of our
customers. If problems should occur, please refer to
Troubleshooting. If the problem persists, then feel free
to contact our after-sales support hotline using the
following number:

After-sales service
� I+ME ACTIA GmbH

Rebenring 33
D-38106 Braunschweig

Germany.

� ++ 49 (531) 38 701 38
Fax : ++ 49 (531) 38 701 88

��� e-mail : info@ime-actia.de
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1.2 Optional System Requirements

PC requirements for the optional use of PCMCIA cards
for different configurations, to update system and to
exchange data.

•  standard PCMCIA drive with standard memory
access drivers

•  PC with Pentium 133 MHz

•  16 MB RAM min.

•  Windows 95/98 or Windows NT
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1.3 Delivery Contents

1.3.1 Standard

Your NetTest III+ delivery package includes:
(Order code: 2003 402)

•  1x NetTest III+
•  1x System user manual (hardware/software).
•  CAN firmware as HEX file.
•  “ConfigPlus” configuration program.
•  “TransLog” program to convert logged data.
•  Transfer tools for data exchange between PC and

PC cards.
•  Adapter cable set:

1x SUB-D 9
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1.3.2 Supplementary Support

•  ChipSetup software

•  SRAM cards

•  Flash cards

•  Different cables for protocol interfacing (on request)

•  Protection Case
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1.4 Technical Specifications

General characteristics of NetTest III+

Processor 80C165 , @18,432 MHz
Protocol Interface SJA100, @ 16 MHz
Physical Interface CAN  I: according to

ISO 11898 (PCA 82C251)
CAN II: according to
ISO 11519 (TJA1053)

Memory 512 KB x   8 Flash
256 KB x 16 SRAM
    8 KB x   8 EEPROM

Temperature Range -20°C .. .+ 65 °C
Connector 9pin sub-min-D

CAN according to CiA/DS 102
or customer specific

Housing ABS plastic, protection class IP30
Display LCD illuminated ,

64 x 128 pixel, 62,5 x 43,5 mm
PCMCIA Interface according to Type II, Level 1 of

PCMCIA standard
Keyboard PET foil keyboard with 16 keys
Dimensions 100 x 119 x45 mm
Power Supply switched-mode power supply

12/24V DC (7-32V DC)
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Options

UART On request

RS232 For programming and
debugging

Cable 1 m cable for adaptation

I/O 1 x analogue input



2 Hardware

The components which make up your NetTest III+ and
the way they work together.
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2.1 General

The NetTest III+ electronics includes the following
components:

•  Power Supply - the regulated power supply has an
input voltage range of 7.5V .. 32V.  The nominal
output current is 0,6A @ 12V.

•  CAN Transcelver (High Speed) - as high speed
CAN transceiver a circuit Philips PCA82C251 is
used as certificate in the ISO 11898.

•  CAN Transcelver (Low Speed) - as low speed
CAN transceiver a circuit Philips TJA1053 is used
as certificate in the ISO 11519.

•  PCMCIA Slot - for data transfer and program
download via one 16 bit memory card a PCMCIA
slot is integrated in the NetTest lll+.  Hot plug-in is
allowed.

•  Cable ID detection - three digital input lines are
used for an identification of the connected cable and
its using.  In a first step the lines are used CAN high
speed / low speed selection only.  This means
depending on the logic levels on these lines either
the "Low Speed CAN"transceiver or the "High
Speed CAN"transceiver is selected.
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•  Digital IN - the digital input port (1 Bit) is designed
for voltages of 0 .. Ubat.  The threshold for a logic
"High" level is 6V. The input impedance is greater
than 20kOhm. This input is protected against
overvoltages.

•  Digital OUT - the digital output port (1 Bit) is
designed for voltages of 0..Ubat. lt is an "Open Drain
Output" for currents up to 20mA. This output is
protected against short circuit.

2.2 Powersupply

The Power Supply is realized as a regulated power
supply. NetTest lII+ has an input voltage range of
7.5V .. 32V- The power have to be connected via the
CAN connector pin 9 and 6 or via the Binder connector.
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2.3 Microcontroller

The l+ME NetTest lII+ includes the 16-bit Siemens
80C165 micro controller on a piggy back.  The
controller's clock frequency is 18,432 MHz to realize the
baud rates on the RS232 interface.

The following baud rates are supported:

Baudrate / Bd Tolerance
19200 1%

9600 1%
4800 1%
2400 1%
1200 1%

2.4 Mernory

The l+ME NetTest III+ is equipped with
256 KB x 16 bit SRAM
512 KB x 8 bit Flash

8 KB x 8 bit EEPROM

This constellation is supported today, in future other
configurations are possible.

2.5 Protocol Interface

The product has one SJA 1000 CAN-protocol chips at a
frequency of 16 MHz.
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2.6 Physical CAN Interface

NetTest lII+ is designed to fulfil the requirements of in-
vehicle applications.  Therefore it is equipped with two
transceiver chips.
One of them is in accordance to the standard ISO
11898.
The other physical line driver is in accordance to the
standard ISO 11519. lt is realized by the usage of the
transceiver chip TJA1053.
The selection of the physical line driver is done
automatically.  For each exists a special cable which is
encoded and assigned to the suitable physical line
driver.
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2.7 Physical Cable connections

2.7.1 19 Pin connector

At the top of NetTest lII+ you reach two connectors from
company BINDER. One 19 pin and one 14 pin
connector.  The 19 pin connector is used to plug in the
CAN-Base-Cable. For pinning see next page.

19 Pin
Base

connector14 Pin
Multifunction

connector
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19 Pin connector

Pin Signal
A Cable ID 0
B RxD (RS 232)
C TxD (RS 232)
D DTR (RS 232)
E Digital In
F GND (Power)
G Battery Voltage
H CAN_L (Low Speed)
I CAN_H (Low Speed)
K CAN_H (High Speed)
L CAN_L (High Speed)
M Analog In
N Cable ID 2
O Digital Out (open drain)
P GND (Power)
R Battery Voltage
S Cable ID 1
T GND (Signal)
U GND (Analog)
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2.7.2 CAN-SUB-D cable

Pinning of CAN-SUB-D Cable:



Hardware
Physical Cable connections

1.20
2-9

2.7.3 High-Low speed adaptation cable

To separate the cable for different application fields
three digital input lines are used for an identification of
the connected cable and it's use.
The table below describes the coding and the usage of
these adaptation cable.

Coding of adaptation cable:

Cable
ID 2

Cable
ID 1

Cable
ID 0

Cable type /
Used for

0 0 0 0, t.b.d1

0 0 1 1, Low-Speed CAN
0 1 0 2, High-Speed CAN
0 1 1 3, t.b.d
1 0 0 4, t.b.d
1 0 1 5, t.b.d
1 1 0 6, t.b.d
1 1 1 Not used

0: the corresponding ID line is connected to GND
1: the corresponding ID line is left open

Note: Pin N = ID 2 is connected with GND in the
19 pin connector cable (CAN-Base-Cable).

                                                     
1 t.b.d: to be defined
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2.7.4 14 Pin connector

Optional the NetTest lII+ is equipped with the 14 Pin
mode. The tabie below desceribes the pinning of the 14
pin BINDER (Series 1678) connector at the top of
NetTest lIl+.

Note: These function only supported if you orded the
corresponding package.

Pin Signal
A GND (Signal)
C Schmitt-Trigger In
E Optional I/0 1
G Optional I/0 2
J Optional I/0 0
L GND (Signai)
M SCLK
N /SCLK
O GND (Signal)
P MTSR
R /MTSR
S GND (Signal)
T MRST
U /MRST
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2.8 PCMCIA Card Connector

NetTest III+ has a PCMCIA card connector according to
type 11 standard, 16 bit PC card host adapter for
memory cards.  The adapter is in accordance to the
PCMCIA "PC Card Standard" dated February 1995.
The following restrictions are given:
•  1 socket
•  memory card supply 5V DC only
•  maximum power supply current 250mA @ 5V
•  1 memory window with max 64 KB size to the PC

cards common or Attribute memory 8 bit access

The NetTest III+ standard firmware makes it possible to
work with all SRAM PC cards.  You can also work with
e.g. Flash-cards or all type 11 standard cards because
you can control every line of the PC card connector.

Fore the usage of Flash memory cards make sure that
the programming voltage of the memory card is in the
range of the supply voltage.
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2.9 lnputs/Outputs

Digital IN (1 bit)

The digital input port is designed for voltages of
0 .. Ubat. The threshold for a logic "High"- level is 6V (at
the input pin).  The input impedance of this port is
greater than 20kOhm.  The input is protected against
overvoltages (+/- 30V).

Digital OUT (1 bit)

The digital output port is designed for voltages of
0 .. Ubat. lt is an "Open Drain Output" for currents up to
20mA.  The output is protected against short circuit up
to 30V.
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2.10 Casing components

2.10.1 Housing

The housing is a modified type "OKW Datec-Mobil-
Box M".  The housing is made of ABS plastic.  Inside
the housing is coated with aluminum. lt is resistant
against Diesel oil, see water, weak caustic solutions and
it is limited resistant against petrol, hydrochloric acid
(10%) and atmospheric conditions.  The external
dimensions are approximately 195mm * 101mm *
44mm. (See annex for more information).  The
modifications are milling of wholes for the display and
connectors as well as shorten of fixing points for the
internal electronics.

2.10.2 Keyboard

The handling of the NetTest III+ is realized by a 16 key
foil keypad.  The base material is structured polyester
(PETP) with 150µm thickness.  The keys are arranged
in a 4 * 4 matrix (electronically).  Each key has a lifetime
grater than 1.000.000 cycles.  The contact bounce is
100ms maximum.  The foil is resistant against petrol,
Diesei Oil, Kerosin, weak acid solutions, weak caustic
solution, cleaning agents.  The dimensions are 81mm *
168mm.  The keypad is fixed to the housing with the
adhesive 3M 467.

2.12.3 Display

The NetTest III+ is equipped with a 128 x 64 pixel
illuminated graphical display.  The illumination is
realized by a green-yellow LED back light.  The display
type is AG64128LGS-NY-H-202 by ACTRON.





3 I+ME Software

How to work with your NetTest III+.
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3.1 Power On And Main Menu

When you switch on NetTest III the following screen will
be displayed for two seconds.

Please remember the number of the version, if you call
the I+ME After Sales Service.

After that the following display is shown:

Version and SerialNo are shown. The next line shows
the name of the downloaded configuration file (e.g.
ANTrieb) and the type of physical layer (e.g. high speed
CAN).

-----NetTest 3-----

Version: X.x

Date: dd/mm/jjjj

I+ME GmbH - a company

of the ACTIA group

NetTestIII by I+ME

Version: X.x

SerialNo: xxx

ANTrieb

high speed CAN
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NOTE: The first three characters of the configuration file
name are for interest (here ANT). The NetTest III+
detect in this case the right config file. It is possible to
work with other filenames but expedient to use the
following ones:

ANTxxx.cfc for Antriebs-CAN-Bus config-files
KOMxxx.cfc for Komfort-CAN-Bus config-files
XXXxxx.cfc an error occurs (warning only)

After a few time the following screen is displayed.

With help of the arrow buttons the high lighted line can
be moved up and down to choose the wanted item.
In which direction the high lighted line can be moved is
shows left sided in the first line by the arrow.

↓ Mainmenu

1 CAN messages

2 CAN diagnostics

3 Select config.

4 Select filter
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After moving the high lighted line to the button of the
screen the next item became visible

NOTE: As long as NetTest III+ is not in the item CAN
messages , it does not have any impact on the CAN bus
(acknowledge slot).

↑ Mainmenu

4 select filter

5 Update config.data

6 Special functions

7 Restart
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3.2 Editing Data With NetTest III+

•  NetTest III+ reacts on keyboard strokes after the
pressure has been released.

NOTE: If the CAN bus is very busy, that means the
busload is very high, it is possible that the keyboard
react torpidly. In this case the button must be pressed
for a longer time.

•  Number input can be achieved by keystrokes, to
select letters you have to press multiple sometimes.

•  By using the “cursor” you get to the next menu-field.

•  Use the key “↵↵↵↵ ” to get to the next menu item.

•  The “ESC” key takes you back to the previous menu.

Cursor Keys

number field

Enter Key
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3.3 CAN messages

After selecting the item “1 CAN messages“ the
following screen is displayed.

On the screen the Nodenames are displayed (normally
ECU-names). This screen shows an example, because
the contents of the display depends on the definitions in
the configuration file.This file can be edit by the user or
by I+ME ACTIA, if you like. How to edit a configuration
see chapter PC-Software with the explanation of
ConfigPlus.

If messages be received from the CAN bus for a defined
Node(ECU), on the right side an activity mark is
running.

NOTE: The screen above shows only a screenshot, the
character runs from 0..9, A..F.

After selecting one of the Nodenames by using the
highlighted line and pressing “↵↵↵↵ ” key, the messages are
displayed with their names.

Nodename Selection

ZKE F

BSG 1

Gateway 8

TSG_HR A
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The screen shows the identifier in hex-format and the
cyclic times in ms. If time is 9999 is displayed no
message is receive.

If one message is selected the hidden information of the
data bytes is shown in text comments. These text
comments of data are defined in the config file.

Message Display

Bremse_1 1a0 10

Bremse_2 5a0 9

Bremse_3 4a0 10

Kombi_1 320 9999

Sig. Bremse_1

ABS_Brems ok

Diagnose aktiv

Geschw. 125km/h

Drehz. 3000U/min
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3.4 CAN diagnostics

After selecting the item “2 CAN diagnostics” you see
the following screen.

Busload
shows the traffic on the CAN Bus in %

BusOff
counts how often the CAN-controller is set on bus off.
Normally the CAN-controller is set in BUSOFF mode if
the Errframe counter is reached the 255 limit. In this
case the controller gets a reset to prevent that
diagnostics stoped.

Warnstate
counts how often the CAN-controller reached the
ErrorPassivMode.

Errframe
counts the received Errframes.

NOTE: The counters in this menu can reset if you press
the “↑↑↑↑ ”-key for a longer time. Importing if you are log
data with a triggerpoint into an Errorframe.

CAN diagnostics

Busload : 30%

BusOff : 0

WarnState : 0

Errframe : 0
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3.5 Config. Selection

After selecting the item “3 Select config.” you see the
following screen.

In this submenu one of the two configurations can be
selected. If a new configuration should be loaded one of
these must be overwrite.

Config. Selection

ANT_22a.cfc

KOM_08.cfc
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3.6 Select filter

After selecting the item “4 select filter” you see the
following screen.

In this item filter which defined in the configuration can
selected by moving the highlighted line. How to define a
configuration file see chapter PC-Software.

Filter Selection

Default

TestDemo
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3.7 Update config. data

After selecting the item “5 Update config. data” one of
the following screen wiff display:

PCMCIA card not present
If no PCMCIA card is in the PCMCIA slot the following
information is displayed.

After pressing one key you go back to the main menu.

PCMCIA card inside
If a PCMCIA card is in the PCMCIA slot the following
information is displayed.

The lines under the topic Config. Update show the
configuration files which were saved on the PCMCIA

Error occured

No PCMCIA inside

Hit any key to

continue

Config. Update

ANT_T05C.CFC

ANT_T004.CFC

ANT_T05E.CFC

KOM_061Y.CFC
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card. To select a file move the high lighted line by using
the arrow keys and press “↵↵↵↵ ”-key.

After your selection the following screen is displayed.

In the NetTest III+ the last two configurations are
available. If a new configuration should be downloaded
one of the old configurations must be overwrite.

After choosing the configuration file which should be
overwrite the following screen is displayed.

The NetTest III+ loads all necessary information from
the PCMCIA card.
After finish the downloading NetTest III+ goes back to
the main menu.

Config. Seletion

ANT_T05C

ANT_T004

for overwriting

Config. Update

Writing ..........
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3.8 Special functions

After selecting the item “6 Special functions” you see
the following screen.

The following sides described the menu items:
•  Data Logging
•  Transmission Object
•  Baudrate

Special Functions

Data Logging

Transmission Object

Baudrate
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3.8.1 Data Logging

After selecting the item Data Logging the NetTest III+
collects the CAN Bus messages on the PCMCIA card.

You have to format the PCMCIA card by using the
following display:

Start the formating of the card by pressing the “↵↵↵↵ ”-key.
You reach the “Trigger Define” display after
formating the memory card. The PCMCIA card can be
read by the tool TransLog from I+ME ACTIA.

3.8.1.1 Explanation of trigger define

After formating the PCMCIA card you have to define
some trigger options. For better understanding the
following paragraph discribed th memory mechanism.

PCMCIA card format

Format the card ?

ESC-Cancel

Ret-Format

Trigger Define

Type : No Trigger

Value : 0

Pretrg.: 0ms

Aquire :all
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The architectur of the memory saving algorithm is like a
circle. The logged data were saved on the card in a
circle buffer mode. If the last writen position is reached,
the oldest data on the card was overwrite.

For event controll it is possible to define one triggerpoint
and one pretriggerpoint. If the trigger event is occur, the
data saving ends bevor the triggerpoint is reached twice
or the pretriggerpoint is reached (see pictures below).

cycle
memory

pretrigger (-)

pretrigger(+)

triggerpoint

cycle
memory

cycle
memory

pretrigger (-t)

pretrigger = -t

pretrigger = 0

triggerpoint

triggerpoint

last data

last data
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Menuitem Type

To define the trigger you can choose under 7 conditions
they are selectable by pressing “←” or “→”.

1. No trigger
If you choose this item the datalogging starts
immediately. It stops if the card memory is still fuff.

2. On key
Start logging if you press “↑ ”-key and stops if the
pretriggerpoint is reached or you interrupt logging
with the “↵ ”-key.

3. On CAN Err
Start logging if the first ErrorFrame on bus is occur
and stops if the pretriggerpoint is reached or you
interrupt logging with the “↵ ”-key.

4. On CAN Rx
Start logging if a dataframe with a special identifier
(defined in value) is received and stops if the
pretriggerpoint is reached or you interrupt logging
with the “↵ ”-key.

5. DIN Level
Start logging if a high or low level is detect on digital
input and stops if the pretriggerpoint is reached or
you interrupt logging with the “↵ ”-key.

6. DIN trans.
Start logging if a rising edge or falling edge is detect
on digital input and stops if the pretriggerpoint is
reached or you interrupt logging with the “↵ ”-key.

7. ADU trg.
(Not implemented in this version)
Start logging if the sample voltage is reached
(defined by value). Stops if the pretriggerpoint is
reached or you interrupt logging with the “↵ ”-key.
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Menuitem Value

In this menuitem you can select values by using the “←”
and “→” key. The input is possible only if you choose
trigger type 4 – 7. In dependence on your choise the
values have other meanings:

4. Value can only reached values wich are defined in
the configuration file.

5. Value can only reached 0 or 1. These values are
the level of the digital input channel , 0 for LOW and
1 for HIGH.

6. Value can only reached 0 or 1. These values
corresponding with the edge signals. The 0 is the
falling edge and the 1 is the rising edge.

7. (Not implemented in this version)
Value defined the sample point of voltage from the
AD unit. The steps are defined by the used AD unit.

Menuitem Pretrigger

The pretrigger defines the time bevor or after the
triggerpoint. Is the pretrigger reached, no more data
was overwrite.
Example: You choose “On CAN Err”. In this case the
data before the triggerpoint is reached are very
interesting in many times. So you define a pretrigger as
–500. The pretrigger time scale is [ms].

Menuitem Aquire

With this item you choose if all data are logged, or if
only the data wich are in the config file defined be
logged.
Advantage: By choosing “Msg. list” the time to log data
can be rised up considerable.
You can read data on PC from PCMCIA card by using
the tool TRANSLOG from I+ME ACTIA.
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After the input of trigger configuration you have a
possiblility to type in a comment. Choose this possibility
to save the history of the data you have logged.

Insert comment
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3.8.2 Transmission Object

After selecting the item Transmission Object you see
the following screen.

With these two menuitems you can control all transmit-
funktions of the NetTest III+.

3.8.2.1 CAN Object Definition

After selecting the item CAN Object Definitions you see
the following screen.

On this screen you can define transmission objects
without using a personal computer. You can define
maximal two transmition objects in online mode.
If you press “↓ ”-key you can reach more items of the
menu “CAN Tx Definition”

Transmission Object

CAN Object Definition

CAN Select Menu

↓CAN Tx Definition →

TKey: 0

ID :0x 0

Name: tx0

Len : 8
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The following discribes the items you can define:

•  Tkey
... is the number of transmition objekt

•  ID
... define the identifier of the transmitted object in
HEX-format.

•  Name
... gives the transmit object a name.

•  Len
...defines the length of the databytes.

•  Cyc
... defines the transmit cycle time in range to
5 .. 9000 ms.

•  Mode
... decides between cyclic and burst transmit:
0 = cyclic transmit mode
1 = burst transmit mode

•  Dat0
... define the content of the databytes of the transmit
object.

•  Dat1
... the same as Dat0 only for transmition object 1.

↓CAN Tx Definition →

Len : 8

Cyc : 100 ms

Mode: 0

Dat0:00000000000000
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3.8.2.2 CAN Select Menu

After selecting the item Transmission Object you see
the following screen.

On this menu you can choose witch transmit object shall
be send by NetTest III+. You can select max. 2 object
from a list consist of the object from the config file and
the two object you have define direct on NetTest III+.
The tool ConfigPlus help you to define the transmit
object on your PC.

The selected objekts get an activity mark if you choose
them with pressing the “↵↵↵↵ ”-key..

Send data on mode 0 (cyclic)
Press key “→” ones, the Tx object with content Dat0 will
be transmit.
Press key “→” twice, the Tx object with content Dat1 will
be transmit.
Press key “←”, the transmition will be stoped.

Key: → → → → ←
Object: Dat0 Dat1 Dat0 Dat1 stop

CAN Tx Selection

Fenster1 01 nor

Tuer 00 alt 8

Test 00 nor

Klima 01 alt
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Send data on mode 1 (burst)
Press key “→” ones, the Tx object with content Dat0 will
be transmit cyclic.
Press key “→” twice, the Tx object with content Dat1 will
be transmit for 5 cycles, then transmition is stop.

Key: → →
Object: Dat0 5x Dat1 stop
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3.8.3 Baudrate

After selecting the item Baudrate you see the following
screen.

3.8.3.1 Manuel Selection

After selecting the item Manuel Selection you see the
following screen.

One of the shown baudrates can be selected by moving
the high lighted line and press “↵ ”-key.
To edit a new baudrate see Edit Baudrate.

Baudrate Selection

Manuel Selection

Detection

Edit Baudrate

Manuel Selection

500 kBaud

250 kBaud

62 kBaud
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3.8.3.2 Detection

After selecting the item Detection you see the following
screen.

The NetTestIII analyses the CAN bus transmission rate
and shows the result in the high lighted line.

Note: Only defined baudrates can be detect by this
menu item.

The baudrate detection depents on a defined table. This
table includes all possible detectable baudrates. For
faster detection you should be place the probable entry
on the first position of this table. For more information
see next chapter.

Baudrate Detection

500 kBaud
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3.8.3.3 Edit Baudrate

After selecting the item Edit Baudrate you see the
following screen.

On this submenu a new baudrate can be defined. On
the screen all defined baudrates are displayed.

To define a new baudrate move the high lighted line to
the end of the list.
Press the “→” key to increase the new baudrate.
Press the “←” key to decrease the new baudrate.

If you choose an empty line, you can clear the entry.

Note: You are only able to clear the last entry on the
list.

If you choose a defined baudrate you can change the
defined speed.

3.9 Restart

After selecting the item Restart NetTestIII+ is reset and
starts new.

Baudrate Editing

500 kBaud

250 KBaud

62 kBaud
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4.1 An overview of ConfigPlus

ConfigPlus is a product of I+ME ACTIA.  Using
ConfigPlus you can configure the CAN-tester NetTest
III+ easily using PC-support.  ConfigPlus integrates
three tools under a easy to use Graphical User Interface
and simplifies the configuration of the NetTest III+.

The preparation of a configuration file that the NetTest
III+ can read is done in three phases.  In each of the
phases the user must first activate the tool and then
open the corresponding file.  The active tool is marked
with a check in the Edit menu.

•  In the first phase a *.dbc file is converted into a
source file(*.ime) through the Windows-
consoleapplication LISAdb.

•  In the second phase the *.ime file can be edited in
the configuration-editor.  It can change the *.ime file
by adding to or deleted entries. Furthermore data-
base-sections can be extracted, message- and
signal-filters, as well as a table for transmitted
messages can be inserted. The alterations of the
user can be examined with Syntaxchecks.  The
modified data is then saved in the *.cfg file-format.

•  In the third and final phase the *.cfg file is converted
into binary using Transnet.exe.  The binary data is
saved as a *.cfc file which NetTest III+ can read.
This file can then be copied on a PCMCIA-SRAM-
card and used in the NetTest III+.
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4.2 Installing ConfigPlus on your PC

To install the configuration tool ConfigPlus requires a
PC or laptop with the operating system Windows 9X or
Windows NT and PCMCIA-card slot.

To install the software start the program "setup.exe" and
follow the instructions for the installation program.
The program copies the necessary files to the hard disk
of the PC and makes the program ConfigPlus ready to
run.

To starts the program click the start button and find
ConfigPlus in the start menu.
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4.3 Working with ConfigPlus

After starting the program ConfigPlus you see the
following window on your monitor.

Looking at the upper section of the application you
found the section “General Information”. Type in name,
version-number and date about your configuration.
Located in the lower section of the applacation is found
the tabs for the editing field.  Included here is the
Information “ General” of the loaded configuration-file,
Rx messages, Tx messages, Signals, the Signal-texts
and the Filters.
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4.3.1 The Menus

The 4 menus showen across the top of the applacation
are dropdown menus. The menus are labeld File, Edit,
SyntaxCheck and Options.

4.3.1.1 The File Menu

NOTE: Before a new file or an existing file can be
opened from the "File" menu the correct data type must
be selected form the "Edit" menu. !!(see section 4.3.1.2)

New
Generates an empty *.ime session.

Open Example
Opens an included example file named "default.ime".
With the help of this file you can get an overview of the
editing possabilties of ConfigPlus.

Open
Opens an existing *.ime- or *.dbc-file
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Save
Saves the configuration under the already assigned file
name.

Save As...
Saves the configuration under a new file name.

Print
Prints the configuration file as text file.  The document is
printed in landscape mode.

Exit
Exits the program “ConfigPlus”.
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4.3.1.2 The Edit Menu

From the "Edit" menu you can selects the type of file to
be worked on.
From here you can convert the generated *.cfg-files into
*.cfc-files.The lines can be edited and the Cut and
Paste function can be used.

LISAdb
When "LISAdb" is activate the Menu option "File-Open"
converts a *.dbc file into a *.ime file with help of the
program LISAdb.exe.  Compiling mistakes are shown in
the failure list.

Configuration Editor
When "Configuration Editor" is activate the Menu option
"File-Open" opens a *.ime file.  This *.ime file can be
edited with help of the ConfigPlus program editor.
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Copy To
Saves file(*.cfc/*.hex/*.h86) onto a chosen medium, for
example a SRAM-card.

Convert Cfg -> Cfc
After the *.ime file is saved as a *.cfg file the function of
the menu option "File-Save as" generates a *.cfc file.
This file can be directly loaded into the NetTest III+.

Paste/Cut
The standard windows functions used to paste or cut
from the clipboard.

4.3.1.3 SyntaxCheck

To make sure that the number of configuration-mistake
is as low as possible ConfigPlus can perform a series of
Syntaxchecks.  Syntax checks can only be made with
*.ime or *.cfg files.
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Duplicated Short-names
The use of double short-names in the message table is
not allowed.  ConfigPlus executes a Syntaxcheck
examining short-names by parity.  This function is 'case
sensitive' meaning the capitalized- and lowercase letters
are looked at as different symbols.
When a double short-name is recognized a warning
appears in the error list.

Empty Short-names
Checks to if the Message- or Signaltable includes empty
short-name-fields.  If there is an error then a warning
appears in the error list.

CANMsg-Length
The field message length in the message table can only
include values of 0...8 (byte).
When the CANMsg is to long then a warning is added to
the error list.

CAN Identifier
There can not be a double CAN-Identifier in the
message table.
When a double CAN-Identifier recognized then a
warning appears in the error list.

Multiplexsignals
The Multiplex field in the signal-table may only include
definite values. Therefore ConfigPlus executes a
Syntaxcheck examining the content of the Multiplex
field. Only the values (-1), (-2) and 0...1023 may be
entered for the Signalkey in the Multiplex field.
If the Signalkey value in the multiplex field has a value
of (-1) then the SignalValue in the Multiplexfield must
have a value of (-1).
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If the Signalkey value in the multiplex field has a value
of (-2) then the SignalValue in the Multiplexfield must
have a value of (-2).
If the Signalkey value in the Multiplex Field has a value
of 0...1023 then the SignalValue in the Multiplex field
must have the value of 0...1023.
If there is an error then a warning appears in the error
list.

All
Runs through the all the Syntaxchecks and shows any
errors as warnings in the errorlist.

Clear Error List
Clears the error list of any previously log errors.

Print Error List
Prints the error list to a local or network printer.

4.3.1.4 Options

Show Select Signal
After selecting of one Rx message and call this menu
item only the signals of this Rx message should be
shown.
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Disable Selection
Disables the function “Select Signals Shown”

Auto Generate Short Names
Configplus has the ability to generate automatically
shortnames from the longnames

Convert Signal Texts
With ConfigPlus it is possible to optimize existing signal
texts into short texts

Sort
ConfigPlus can define new index of the table for
messages and signals.  This should be useful after
deleting or adding new items.
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4.3.2 The “General” Tab

General Information
In these three fields one can entered the Name, the
Version Number and Data.

Comments
In this field one can enter comments.  The comments
must start with a #.

Errorstring
When performing SyntaxChecks on a open *.dbc file,
the error messages are shown in this window.
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Data Base Information
The elements in a configuration file have certain size
restrictions.  They are:

Rx Messages: Max. 128 Messages
Tx Messages: Max. 16 Messages
Signal: Max. 512 Signals
Signal Text: Max. 1024 Texts
Filter: Max. 16 Filters

Max. 32 Messages in one
Filter
Max. 32 Signals in one
Filter

When the one goes pass the maximum from one of
these elements a warning message is showen in the
Errorstring window.

File Information
This window show the configuration file’s size in bytes
and how many line are contained with in the opened file.
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4.3.3 The “Rx Message” Tab

When using ConfigPlus you have the possibility to
manually insert new fields in the Rx message table. The
new structure must be completely filled out.  If it is not
then a warning message will be shown in the error field.
All existing fields are also editable.

In the Rx Message window can be seen a table with 8
collums.  To add another line to the table look in the
Menu under “Edit” then chose “New Line”.
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4.3.3.1 New Line/Edit Line

After choosing the option “New Line” or “Edit Line” The
following window will appear.  This window can also be
opened by double clicking on an existing**  line.

In these window fields it is possible to edit or enter new
data into to the Rx message table.
The following parameters must be entered into the
fields:

MSGKey
Servers as the number for the Rx message.

CAN-ID
Defines the receiving identifier.

Message Name
Defines the name for the configuration.

Short Nmae
Defines the name to be shown on the NetTest III+
display.
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CAN-Len
The number of databytes (1-8) in the receiving
message.

SAbstand
Is set to 0.  This is not used by the current version of
ConfigPlus.

SMode
Is set to 0.  This is not used by the current version of
ConfigPlus.

SName
Defines the name of the station of the message.
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4.3.4 The “Tx Message” Tab

When using ConfigPlus you have the possibility to
manually insert new fields in the Tx message table. The
new structure must be completely filled out.  If it is not
then a warning message will be shown in the error field.
All existing fields are also editable.

In the Tx Message window can be seen a table with 8
collums.  To add another line to the table look in the
Menu under “Edit” then chose “New Line”.  To edit an
existing line one must choose from the file menu “Edit-
Edit Line” or one can double-click on an existing line.



PC-Software
Working with ConfigPlus

1.20
4-18

4.3.4.1 New Line/Edit Line

After choosing the option “New Line” or “Edit Line” the
following window will appear.  This window can also be
opened by double clicking on an existing**  line.

In these window fields it is possible to edit or enter new
data into to the Tx message table.
The following parameters must be entered into the
fields:

MSGKey
Servers as the number for the Tx message.

CAN-ID
Defines the sending identifier.

Short Name
Defines a small name for the sending message.

CAN-Len
The number of databytes (1-8) in the sending message.

SAbstand
Shows the reputation time [5ms-9s].
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SMode
Defines the send mode to reputation or burst. (see
chapter 1.8.2.1 CAN Object Defintions)

SWert1
Defines the standard message content in the message.
The single databytes must be separated by a space.

SWert2
Defines the alternative message content in the
message. The single databytes must be separated by a
space.
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4.3.5 The “Signal” Tab

When using ConfigPlus you have the possibility to
manually insert new signal fields in the Signal table. The
new structure must be completely filled out.  If it is not
then a warning message will be shown in the error field.
All existing fields are also editable.

In the Signal window can be seen a table with 15
collums.  To add another line to the table look in the
Menu under “Edit” then chose “New Line”.  To edit an
existing line one must choose from the file menu “Edit-
Edit Line” or one can double-click on an existing line.
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4.3.5.1 New Line/Edit Line

After choosing the option “New Line” or “Edit Line” the
following window will appear.  This window can also be
opened by double clicking on an existing**  line.

In these window fields it is possible to edit or enter new
data into to the Signal table.
The following parameters must be entered into the
fields:

SIGKey
Serves as the number for the Signal.

Signal Name
Defines a name for the signal in the configuration.

Short Name
Defines the name to be shown on the NetTest III+
display.

MSGKey
The link to the Rx message table and defines which
message the signal shows.
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Mpx-Key
Defines a Multiplexsignal.  –1 is no Multiplexsignal, -2
defines the multiplex code and values from 0-1024
show the link the Signal.

Mpx-Value
Defines a Multiplexsignal.  –1 is no multiplexsignal, -2
defines the multiplex code or shows the value of the
multiplex message.

StartBit
Defines the startbit of the signal.

Bit Length
Gives the length in bits of the signals.

Factor
Gives the multiplying value for the signal.

Offset
Gives the adding value of the signalvalue.

Min
Gives the minimal value of the singlevalue.

Max
Gives the maximum value of the signalvalue.

End Value
Gives the error value and the default setting of the “err”

Unit
Points out the signal to an unit.

Reciver List
Shows the receiver.
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4.3.6 The “Signal Text” Tab

When using ConfigPlus you have the possibility to
manually insert new Texts in the Text table. The new
structure must be completely filled out.  If it is not then a
warning message will be shown in the error field.
All existing fields are also editable.

In the Signal Text window can be seen a table with 3
collums.  To add another line to the table look in the
Menu under “Edit” then chose “New Line”.  To edit an
existing line one must choose from the file menu “Edit-
Edit Line” or one can double-click on an existing line.
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4.3.6.1 New Line/Edit Line

After choosing the option “New Line” or “Edit Line” the
following window will appear.  This window can also be
opened by double clicking on an existing**  line.

In these window fields it is possible to edit or enter new
data into to the Signal Text table.
The following parameters must be entered into the
fields:

SIGKey
Serves as the number for the Signal Text.

Signal-Value
Defines the value of the text.

Display Text
Defines the text which is shown.
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4.3.7 The “Filter” Tab

When using ConfigPlus you have the possibility to
manually insert new Filters in the Filter table. The new
structure must be completely filled out.  If not, a warning
message will be shown in the error field.
All existing fields are also editable.

In the Filter window you see a table with 3 collums.  To
add another line to the table choose Menu
“Edit / New Line”.
To edit an existing line you must choose from the file
menu “Edit / Edit Line” or you can double-click on an
existing line.
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4.3.7.1 New Line/Edit Line

After choosing the option “New Line” or “Edit Line” the
following window will appear.  This window can also be
opened by double clicking on an existing**  line.

In these window fields it is possible to edit or enter new
data into the Filter table.
The following parameters must be entered into the
fields:

Name
The name of the filter.

MessageNr & SignalNr
Format: [MSGKey],([SIGKey1],[SIGKey5],[SIGKey7])
Defines the Rx message number and the Signal when
the activated Filter which should be only shown or
logged.
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4.4 Service Structure

Edit → LISAdb

File → Open

*.dbc

*.ime

Convert *.dbc to *.ime

*.ime

File → New /Open

Edit

File → Save as *.ime

File → Save as *.cfg

Edit → Convert Cfg→Cfc

*.dbc

Edit → Configuration Editor
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4.5 Editing configuration file

With the help of a configuration file and the compiler Transnet it is
possible to define a specific NetTestIII configuration.

Structure of the Configuration file *.cfg

<HEAD>   Begin of header-section
           <TITLE>  name of the CAN-data-basis  </TITLE>
           <VERSION>  CAN-Version  </VERSION>
              <DATE>  date  </DATE>

</HEAD>  End of header-section
<MSGTAB>\n  Begin of the message table

        Message table

\n</MSGTAB>  End of message table
<SIGTAB>\n  Begin of signal table

       Signal table

\n</SIGTAB>  End of signal table
<TXTTAB>\n  Begin of text table

      Text table

\n</TXTTAB>  end of Text table
<CNFTAB>\n  Begin of configuration table

      Configuration table

\n</CNFTAB>  End of configuration table
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4.5.1 Elements of the Message Table

Elements Data Type Meaning
MsgKey Integer Referenz to thesignal

table
ID Integer Identifier
Name String Message name
Shortname String Name for the screen
Message Length Integer Length of the

message
Multiplex-code Integer Signal key of the

Multiplex-Code, if the
message is a
multiplex message
else –1

Multiplex-Info Integer Signal key of the
Multiplex-info if a
multiplex message is
used, else –1

Transceiver String Name of the
transmitting note

Transmitting distance Integer Transmitting interval
Transmitting modus Integer 0=const, 1= on action

asynchrony; 2= on
action synchrony



PC-Software
Editing configuration file

1.20
4-30

4.5.2 Elements of the Signal table

Element Data Type Meaning
Signal key Integer Referenz of the Text table

and the MPX-Messages
Signal name String Name of the signal
Signal short name String Short name for the screen
MsgKey Integer Referenz to the message
Start Integer Startbit in the message
Length Integer Signal length
Factor Real Calculation factor
Offset Integer Offset for the calculation
Minimal value Real min. allowable value
Maximal value Real max. allowable value
Error value Integer Error sign
Receiver list String [256] List of receiver notes,

separation mark = ,.

There can be upto 512 defined signals.



PC-Software
Editing configuration file

1.20
4-31

4.5.3 Text Table

Elements Data Type Meaning
Signal key Integer Signal, to the text
Signal value Integer Signal value for the

displayed text
Display text String Displaying text

There can be only upto 1024 texts link defined.

4.5.4 Configuration table

Elements Data Type Meaning
Configuration name String Name of

configuration
List with MsgKeys String Referenz to the

configuration of
messages, MsgKey
separation = ; .

Example for the filter settings:

<CNFTAB>\n
default
CAN_Info         8(85,88,91,96);6(62,65,64,68,69)
\n<CNFTAB>

The filter CAN_Info uses the signals 85, 88, 91, 96 for
message 8 and the signals 62, 65, 64, 68 and 69 for
message 6.

There can be a maximum of 16 different defined filters
within maximum of 32 messages and  upto 32 signals.
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4.6 Example for Creating a Configuration
File

The following section describes a simple example for
creating a configuration file.  This example uses the
movement of the powerwindows.

The represent information is found in 3 databytes.

- Still = 00
- Upwards = 10
- Downwards = 20

A configuration file *.cfg begins with a document
header.  The document header must include the title of
the configuration, version number and the data.

<HEAD>
<TITLE>Tuerbr</TITLE>
<VERSION>1.0</VERSION>
<DATE>01.09.1999</DATE>

</HEAD>

The next step is to enter the data for the message table.
The elements of the message table can be found in
chapter 3.10.2.

<MSGTAB>
0 1544 eWindow eWindow 4

Door 0 0
</MSGTAB>

All elements must be separated by a TAB.
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To set up the signal table the message must be
configured.
It is very helpful to use the following tables.

Position of bits for configuration.

8 databytes: 00 01 20 03 40 05 66 07 (example)

0                        0                        0                        1
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1
7 6 5 4 3 2 1 0 15 14 13 12 11 10 9 8

           2                       0                         0                        3
0 0 1 0 0 0 0 0 0 0 0 0 0 0 1 1
23 22 21 20 19 18 17 16 31 30 29 28 27 26 25 24

          4                        0                        0                         5
0 1 0 0 0 0 0 0 0 0 0 0 1 0 1
39 38 37 36 35 34 33 32 47 46 45 44 43 42 41 40

          6                         6                        0                        7
0 1 1 0 0 1 1 0 0 0 0 0 0 1 1 1
55 54 53 52 51 50 49 48 63 62 61 60 59 58 57 56

The power window information that is interesting is the
bitposition 20-23.

<SIGTAB>
0 powerwindow Richt 0 -1 -1

20 4 1 0 0 2
255

</SIGTAB>
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In next step the value of the 4 configured bits must be
linked to the text.

<TXTTAB>
0 0 still
0 1 upwards
0 2 downwards
</TXTTAB>

For this example we need no Filtermask.

<CNFTAB>
Default
</CNFTAB>



PC-Software
Working with Logging Data

1.20
4-35

4.7 Working with Logging Data

After data is logged (as seen in chapter 3.8.1 Data
Logging) on a PCMCIA-card this data can be worked on
the PC with the help of a application ex. Excel.  To help
convert the Data.par and Data.run into *.txt files is a
program called TransLog.
To perform this function the program TransLog must be
started.
The program exists out of only an input-mask in the
source and distribution-files will write down.

In both lines the Parameter-File and the Logged Data-
File generated from the NetTest III+ must be entered.
These files are Data.par Fehler! Keine Indexeinträge
gefunden.and Data.run.

So that the program TransLog can convert the drawn
data a comprehensible meaning the Configuration File
must be entered into the Configuration File field.  This
file must be the configuration file that was used before
the data was logged.
In the last field must be entered the name of the text file.
The File will be save as *.txt.
To start the conversion click on the start button..
To exit the program click on the exit button..

The file can then be work on in Excel.  If the file is to
large to be worked on in Excel the file can be broke
down into smaller files with the help of WordPad and
then work on in Excel.
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